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WELCOME! 

Thanks for joining us for the all-new TC2000 Training Class for 2013 introducing the brand 
new TC2000 version 12.4! Today you'll learn: 

 The basics of reading a stock chart

 The fastest, simplest ways to navigate TC2000

 The most important features to learn first

 Creating your own Layouts from starter templates

 Keeping your thoughts and favorite stocks organized

 Building EasyScans that you'll use every day

 Mastering the TC Classic+ Layout fresh out of the box

 The best places to find pre-built scans, WatchLists & charts

 Hunting down investment opportunities in the research feeds

 Customizing TC2000 to fit your particular trading style

We hope these notes will help you retain and remember the material we cover throughout the 
day. We have broken the material in five sections to be covered in today's four class 
sessions.  

We have made an attempt to be comprehensive, so there may be material in the notes we do 
not get to cover in the class (or vice versa).  We've also included resource information at the 
end of this document to help you follow up after you leave today's class.   

We hope you enjoy the class. 
Julia Ormond, CMT & Michael Thompson 
TC2000 National Trainers 
Here are some additional things to remember: 

1. Along with TC2000 v 12.4, your current TC2000 version 7 will continue to work as a separate
platform. There is no additional cost to use both.

2. You have access to mobile applications as part of your TC2000 subscription. You can access
the mobile version in your App store by searching for TC2000 or going to www.TC2000.com in
your mobile browser. Please note that mobile versions only work with TC2000 v12+. (Available
for iPad, iPhone, Android phones and tablets and the Kindle Fire.)

3. You can import your settings (PCF's, WatchLists, Chart Templates, EasyScans, etc.) from
TC2000 version 7 either during the installation process of TC2000 or by clicking on the File
menu and choosing the Import Settings from TC2000 version 7.

4. All future upgrades to TC2000 will automatically be present when you log in. New versions will
be accompanied by a message asking if you would like to see the notes concerning what is
new in the program. Click "Yes" to read the update notes.

http://www.tc2000.com/
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Jump Start! What You Need to Know to Start Using TC2000 Today 

Whether you are brand new to TC2000 or have been using it for years, this how-to, hands-on session gives you 
the simple steps and key shortcuts you need to start using your TC2000 out of the box today.  

You’ll learn how to: 

 Use pre-built Layouts, charts, WatchLists, conditions, Scans…all ready for use out of the box

 Create personal WatchLists and add charts to them on the fly

 Easily write personal notes as an integrated trading journal

 Utilize simple hot keys to instantly navigate symbols, time-frames, price plots and libraries

 See and use the latest news, notes and research in a simple one-window format

 Rank any WatchList by any condition with one click through sorting

 Notate your charts with drawing tools

TC2000 features you will use: Pre-built Layouts; pre-built libraries; WatchLists; Basic Indicators; navigation tools; 
basic menus; News & Notes; drawing tools; hot keys 

The TC Classic Layouts 

TC Classic and TC Classic+ Layouts make up the default Layout Group for TC2000. 

To open this default Layout Group, click the File 
menu and select Open Factory Default Layout 
Group 

To access each Layout Tab, click the desired 
Layout tab at the bottom of the screen.  

To open either of the classic Layouts in any 
Layout Group, click the New Layout Tab button 
and select the desired Layout from the menu. 

TC Classic 

The TC Classic, the standard for TC2000 for many years, contains three windows: 

WatchList Window: 
>Default: Nasdaq 100 
>Click WatchList picker to change WatchLists 
>Click column header to sort WatchList 

Notes & News Window: 
>Aggregates news stories, Twitter and TC2000 user 
posts and third party research. 

>Tabbed Windows: My Notes; My Friends Notes. 
>Edit button: change Feeds & properties 

Chart Window: 
>Price history of current symbol with selected 
indicators. 

TC Classic+ 
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The TC Classic+ Layout has everything TC Classic contains, plus several other useful tools. 

Click one of the Indexes in the top-left 
Market Summary WatchList; view the 
stocks that make up that index in the 
WatchList below. 

Click on any symbol to view the list of 
stocks that share Industry or Sub-
industry in the upper-right WatchLists

The Flagged and My Favorites 
WatchLists can be populated by using 
hotkeys: <Shift-F> to flag/unflag, and 
<Shift-V> to add to Favorites list 

 For Platinum users:  Tabbed windows 
are All-TCNet Chat; the Live Help 
Chat, and the Corporate Calendar.  

Main Toolbar Menu 

The Main Toolbar in TC2000 located along the top of the application includes buttons to access most major 
functions of TC2000. 

If you prefer the vertically oriented toolbar, click the icon at the left of the menu toolbar. 

Navigation

In this section, learn the key functions which allow you to navigate the major tools you need to get started using 
TC2000 quickly.  

Convenient hotkeys, shortcuts and techniques help you move through the various features of the program 
effortlessly (see final page of this workbook for a complete list). 

New Button 

The New button on the main toolbar is a quick, convenient way 
to: 

 Add a new tool window to your Layout Tab (blank window,
chart, WatchList or EasyScan)

 Write a new note

 Write a new Personal Criteria Formula (PCF) for an
indicator or condition

 Start a new Layout Tab
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Symbols 

TC2000 contains symbols for the following data feeds with 
online streaming data (up to 15 minutes Delayed+ for gold; 
US real-time data for platinum customers): 
 
US common & preferred stocks 
ETFs 
Forex (24 major pairs) 
Mutual Funds 
Canadian stocks (TSX & Venture TSX) 
Indexes (US & Foreign) 
Nasdaq Bulletin Boards & Pink Sheets 
 
To add or remove any exchange, click  
Tools > Add/Remove Exchanges. 
 
 

Jump 

Simply start typing any letter from A-Z and the search dialog will 
automatically pop up. You may type any part of a ticker symbol or 
company name. Select by clicking on the company name or hit 
Enter on your keyboard. 
 

Spacebar 

While in a WatchList, press the <Spacebar> to move down through the next items. Press <Ctrl-Spacebar> to 
move up through the previous items. You may also use the up and down arrow keys to perform the same 
operation. 

Backspace 

Press the <Backspace> key to go back to the last symbol you were viewing. This is handy for jumping to a 
different stock in another WatchList or in a news story and then immediately returning to what you were doing. 
You may hit the <Backspace> key as many times as you would like to review all your recent stocks. (Please 
note that this is a new behavior for the <Backspace> key. In previous versions of TC2000, it would move up a 
WatchList. Now you use <Ctrl-Spacebar> to move up through a WatchList.) 
 

Linked Symbols 

Symbols that begin as $ in news and notes are clickable links that 
will take you directly to a stock. 
 
 
 

Time Frames 

You can view your price data (up to 25 years of market history) in any of the following time frames: 
 
Tick 
1, 2, 3, 5, 10, 15, 30 minute chart 
1, 2, and 4 hour charts 
1 - 9 Day charts 
Monthly, Quarterly and Yearly 
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Picker 

Click the timeframe picker at the top of your chart to view a drop down with time frame 
choices. Click on the desired time frame to change the price chart. Notice that hotkeys 
are available to change these time frames on the fly from the keyboard. 

Zoom & Pan 

The easiest way to zoom in/out on your chart is with the scroll wheel 
on your mouse. You can also grab the end of the zoom & pan bar at 
the bottom of the chart to zoom. 

Grab the middle of the zoom & pan bar to move back in time. 

You can use the bracket keys on your keyboard to move the chart 
forward or backward one bar at a time. 

Plots 

Select from TC2000's library of over 80 technical indicators, 70 historical fundamental, Industry, Index, Market 
Indicators, PCFs or Stock symbols to add, edit and overlay plots on your chart. 

Add/Edit 

There are several ways to add and edit plots to your 
charts. 

Picker 

Click the Add Plot button at the top of your 
chart to select studies from the indicator library. 

/ Shortcut 

Press the forward slash / key on your keyboard, 
and start typing to add a plot in a new pane on 
the fly. 

Edit 

Click on the plot name in the legend of any pane to access the Edit 
window. This window allows you to adjust any parameters of the plot that 
can be altered. 

Moving/Overlay 

Click the double arrow icon next to any indicator name to change the positions or overlay 
the plots displayed on a chart.  
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Options: 

 
Pin--temporarily move the plot from view without deleting it from 
the chart. You can pin either individual plots or panes that contain 
multiple indicators. 
Insert--assign a new location for the indicator 
Overlay--place the plot in the same pane as another indicator. 
This can be done scaling the plots individually or separately 

 
 

Changing Chart Templates 

Click the chart template name at the top of your chart to open your Chart 
Template library. Select any template to make it your active chart layout. 
 
 
 
 

Write a Personal Note 

Press <Shift-N> to write a note. The chart you are currently viewing will automatically be 
attached to your note. You may also attach other Charts, WatchLists, EasyScans and 
Layouts to your note. The note can be posted to yourself (private), to your friends or to 
everybody (all TC2000 users). Click View My Notes to open all of your notes. 
 

Trendline/Shortcut 

<Shift-D> is the shortcut to open the trendline drawing tool. Simply click where you want 
to start and drag to where you want to end. Click on the trendline itself to Edit or create 
a parallel trendline. 
 
 
 

WatchLists 

TC2000 contains hundreds of WatchLists preconfigured and maintained by Worden 
Brothers. Click the WatchList menu button to see the WatchLists categorized for you. 
 
You can also build as many personal WatchLists as you would like. Below are a 
number of ways you can quickly and easily build your WatchLists. 
 
 

Moving Symbols between WatchLists 

Press <Ctrl-C> to copy the stock you are viewing into a personal WatchList. This also works for multi-selected 
items in a WatchList. You will be prompted to select the personal WatchList into which you want to copy the 
symbol(s). Copy to the clipboard if you wish to paste later to another list or another program. 
Notice you may also create a new personal WatchList on the fly. 
 
You can multi-select stocks in a WatchList by clicking on an item to select it. While holding 
the <Shift> key down, click on another item. All the items in between will highlight as a 
group. Another way to multi select individual items is to hold the <Ctrl> key down while 
clicking on items. Once selected, all operations can be applied to the selected group 
including flagging <Shift-F>, copying <Ctrl-C>, adding to favorites <Shift-V> and writing 
notes <Shift-N>. 
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Adding Symbols to Favorites 

Press <Shift-V> to copy the stock you are viewing into your My Favorites WatchList. This also works for multi-
selected items from WatchLists. 

Flagging Symbols 

Press <Shift-F> to flag or unflag the stock you are viewing. You may also click the 
flag icon in a WatchList. You can multi-select items in a WatchList using <Shift-
Click>. Then <Shift-F> to toggle the flags on for the entire group. Click the 
WatchLists button on the main toolbar and select the Flagged Items WatchList. As 
you flag and unflag stocks, you’ll see them get added and removed from this list. 

Viewing or Changing WatchList Memberships 

Press <Ctrl-M> to see which personal WatchLists the current symbol is included in. Click 
the checkboxes to instantly add and remove the symbol from any of your personal 
WatchLists. 

NOTE: All flagging, copying and personal WatchList maintenance can be accessed by 
right clicking on an item or group of items in a WatchList. 

Columns 

WatchLists contain column sets. Any column can be used to rank any WatchList by the 
value of the criteria.  

NOTE: Columns can also be created with indicators on your chart (see Building 
Conditions section of notes for instructions). 

Sort 

Columns are sortable by simply clicking on the sort column header once for 
descending or twice for ascending order. The small blue arrow indicates the column 
being used and the direction of the sort. 

Add/Edit 

You can add, edit and save individual columns and 
column sets.  

Click the Properties icon in the WatchList to find the Column save functions. 

You can also set default columns for different 
WatchLists.  
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What’s New in TC2000 12.4? 

Because you are attending our free training class today, you are among the first to see the new features of the 
most recent release of TC2000 (even if that release is still in Beta). Here are the newest features and how you 
can access them. 

WINDOWS 

New Floating Windows 

You can now open and float any tool window independent of your TC2000 main layout tab. This allows you to 
drag windows out of your main Layout Tab and dock other tool windows into the new floating windows. You can 
float more than one tool window simultaneously. 

Example: Click on the Chart Tool Menu. Choose the chart you want to 
open.  

The chart appears in an Undocked window which floats only in your 
main Layout Tab. 

Click the Float Window icon in the Undocked window. This 
changes the Undocked window into a Floating Window which 
can now be moved out of the main Layout Tab. 

To drag onto your monitor separate from your main Layout Tab, click and drag the top blue frame of the Floating 
Window. 

True Windows Functionality 

With TC2000 you now have true windows functionality. You can open two or more layouts, drag them to another 
monitor, minimize in your task bar or hide the window behind another. 

Once you have clicked on the Float Window button (described above) 
simply click on the floated windows blue frame and drag or minimize to 
the desired location, including any secondary monitor. 
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You can Tab or Dock multiple tools in any of 
your floating windows. Click the move button 
and then use target mode to select the 
Window into which you want to dock/tab your 
new tool window. 

If you have multiple Tool Windows tabbed or 
docked in a Floating Window, when you click on the X to 
delete it, you are prompted to either Discard (delete) the 
window or make it a tab in the main Layout Group window. 

To save the entire multi-window (or 
multi-monitor) layout group by click 
File, Save Layout Group. 

CHARTS 

TC2000 now gives you multiple Plot types that can be added to any chart. 

Indicators 

There are nearly 80 technical indicators you can add to your charts. New to version 12.4 is the ability to Change 
Data Source--what an indicator is based on. This allows you to make an 
indicator of an indicator. 

Example: 

Press the / key on your keyboard and type TSV® to add the Time 
Segmented Volume® indicator to your chart. 

Click on the TSV® label in the top legend of the new indicator pane. Choose 
Add Plot Here. 

Type Rate of Change and select Rate of change from the 
list. Choose Scale Rate of Change 50 by 
itself.  
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This overlays the Price Rate of Change over the TSV® indicator. Now, to 
make this indicator a Rate of Change of the TSV®, click on the name Rate of 
Change 50 in the top legend of the pane. Choose Change Data 
Source. 

Select TSV® from the list. Your new indicator is now a Rate of 
Change of the TSV® indicator. 

Multiple Price Histories 

You can also now plot multiple price histories in the same Chart Tool Window. 

Press the / key on your keyboard, click the Stocks 
tab and enter the desired symbol in the Select 
Symbol to Plot field. 

You will now see two price charts displayed with the same time frame 
and time span.  

The secondary chart history will not change even as you space bar 
through a WatchList changing your primary symbol.  

DATA 

Sector and Industry data from Morningstar
®

New to TC2000 12.4 are more accurate to the current market and give a broader synopsis of where each stock 
lays in the broad market scheme. The new breakdown is as follows: 

Super Sector & Sector List (with symbols) 

 Cyclical (SSX10)
o Basic Materials (SX10)
o Consumer Cyclical (SX20)
o Financial Services (SX30)
o Real Estate (SX40)

 Defensive (SSX20)
o Consumer Defensive (SX50)
o Healthcare (SX60)
o Utilities (SX70)

 Sensitive (SSX30)
o Communication Services (SX80)
o Energy (SX90)
o Industrials (SX100)
o Technology (SX110)

The 11 Sectors are further divided into 146 
Industries.  

To access these lists by symbol, simply type the desired symbol. 
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To access the WatchLists of Sector Indexes, Industry Indexes or 
Industry groups, click any WatchList drop down and look in the 
Quick Lists section of the WatchList window. (Alternatively, click 
the WatchList menu at the top of TC2000 to open any of these 
WatchLists as an undocked window.) 
 
 
 

Historical Fundamentals 

 

You can now plot Fundamental data historically for up to 30 years. 
To plot any Fundamental field on your chart, press the / key on your 
keyboard, click the Fundamentals tab and type the desired 
fundamental field in the search field. Click on the name from the list. 
 
 
 
 
This will plot your fundamental(s) on your chart and show you the history of 
that criteria for that stock. Change your chart to longer time frames (e.g. 
weekly or monthly) to see more of the history for the price and fundamental(s) 
plotted. 
 
 
 
 

Streaming Real-Time Market Indicators 

The Worden T2 Market indicators now stream in real-time. To access the 
WatchList of T2s click any WatchList drop down, type ‘market’ in the search 
field and choose US Market Indicators from the list. This will open a WatchList 
of the 28 broad market indicators. 
 
 
To add a plot of any T2 on 
your chart, press the the / key 
on your keyboard, click the 
Fundamentals tab and type 
the desired fundamental field 
in the search field. Click on the 
name from the list. 
 
To change your current active symbol to one of the T2 indicators, simply type 
‘T210’ and select the Market Indicator you want form the list. 
 
 

Pre & Post Market Data (Platinum only) 

Platinum TC2000 12.4 users can now see Pre- and Post-market data on any chart.  
 
To access, right-click anywhere on the chart and choose Pre-Post Market data 
from the drop-down menu. Select which view of the data you want to be the 
default.  



12 2013 Training Class Notes TC2000 v.12.4 

EasyScan: The Fastest Way to Find Stocks with TC2000 

Using TC2000’s unique ability to create indicator conditions from the chart, write them with formulas or draw 
them from a pre-built library, EasyScan allows you to instantly search the markets for stocks that look like you 
want them to right now. Whether you are looking for candle patterns, indicator set ups or sound fundamentals, 
EasyScan allows you to combine these behaviors and reduce large WatchLists to manageable size. Plus, with 
Continuous Scanning in TC2000 Platinum, you can have your results streaming in real-time. 

You will learn how to: 

 Create conditions that possess certain indicator behaviors right from the chart

 Combine conditions created in a variety of ways to screen for stocks that reflect your desired behavior

 Utilize multiple time-frames and indicators in a single scan

 Grab and employ simple Personal Criteria Formula for candlestick scanning

 Construct a library of purposeful EasyScans which can be instantly called up for any market conditions

TC2000 Features you will use: EasyScan; condition building from the chart; condition libraries; sorting; 
conditional alerts; time-frames; indicator editing; simple PCFs; column sets 

Building Conditions 

A condition used for sorting or scanning is a behavior or value based on indicators or formula (pre-built or user 
created). For example, price crossing a moving average is a "condition"--an interaction between two plots. 
Sorting has to do with taking a single condition and ranking a WatchList with it. Scanning allows you to combine 
multiple conditions, created in any fashion you choose, to find stocks that meet only those conditions as defined 
by you.  

Creating and accessing such conditions can be done several ways in TC2000. 

Pre-built libraries 

Click the Library menu and choose Conditions. This library contains many pre-
built conditions already loaded into your TC2000. Click the lightning bolt icon 
next to the condition name to run a scan with that single condition.  

This library will also contain conditions you create and save from chart 
indicators or write with Personal Criteria Formula.  

Chart 

To create a condition for sorting or scanning from your chart indicators, click on the 
indicator name in the legend at the top of the pane. Choose Create Scan Condition. 

From the drop down menu, choose the 
particular condition behavior desired. 

Set the remaining parameters for your 
condition as well as save it to your 
condition library. 
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PCF 

You can also create conditions or values using Personal Criteria Formula. Click the 
New button and choose either New Condition Formula or New Indicator Formula. (A 
condition formula is Boolean and returns True or False. An indicator formula returns a 
value and can be plotted as an indicator as well as used for sorting and scanning). 

Enter the formula, choose the time frame to which you want 
the formula applied, name and save the formula. (Note: The 
test button allows you to test your syntax for validity against a 
symbol.) 

For more on Personal Criteria Formula syntax and usage, 
click the Help File and search Personal Criteria Formula in 
the Index. 

Sorting 

Conditions built from the chart or used from the pre-built library can be applied as a sort in any WatchList. 

Sorting from Chart 

Create the condition as directed above. Then choose Add to Existing WatchList or 
Scan. 

This opens Target Mode in all WatchLists or Scans in 
your Layout. Click on Add Column and Sort in desired 
WatchList. 

The WatchList is now sorted 
by your condition with check 
marks appearing for symbols 
in the WatchList that meet 
your condition. 

Sorting from Library 

Open the Conditions library (see above). Click on the desired condition. This opens target mode...proceed as 
described previously. 

EasyScan 

Conditions built from the chart or used from the pre-built library can be combined 
and applied as an EasyScan in a new or existing WatchList.  

Create New Scan 

Create the condition as directed above. Choose Scan in New Window. Your 
EasyScan will run on your default WatchList and bring you the results in a new 
window. 
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To Edit or Add scan conditions, click the Edit Tab. Click the refresh button on the Scan tab 
to run the scan against newer data. Platinum users click the Continuous Scan tab for 
streaming results. 

To set your default WatchList for new 
scans/sorts, choose the desired 
default WatchList from any WatchList 
Picker. Click the Properties icon and 
choose Set as Default WatchList. 

Layering conditions on the fly 

Create any condition as described above. Click the Add to Existing WatchList or Scan 
button. Click Add to Conditions in the desired EasyScan window. 

Click the Add condition button in the Edit tab of your Scan results 
window to add conditions from your condition library. 

Layouts: Create & Customize Your Own Trading Environment 

The powerful Layout concepts in TC2000 allow you to create a personal work environment where you have all 
the tools you want at your fingertips for your stock research. A Layout Tab integrates windows that are arranged 
and interact for very specific reasons. Each Layout Tab can be set up to efficiently simplify your research and 
analysis—whether you’re trading stocks, ETFs, mutual funds or Forex. Creating and customizing your Layout 
Tabs and Groups will make TC2000 uniquely yours and not simply a one-size-fits-all platform. 

You will learn how to: 

 Use starter templates to create Layouts for a variety of purposes

 Customize the properties of charts, WatchLists and tool windows to build visually pleasing set-ups

 Organize, move, rearrange and save Layouts to get designs that make your research fun and easy

 Build an effective library of customized Layouts that fit your trading personality and priorities

 The simple ways you can organize your Layouts with docking, tabbing and moving options

 Personalize your news and notes feed to whatever information you want streaming in

 Create, customize and use column sets for quick WatchList ranking

 Add/edit indicators to your charts

TC2000 Features you will use: Starter templates; move buttons; target mode; chart and WatchList 
customizations; custom system settings; docking/tabbing options; major menus; indicators 
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Customizing Layouts You Use 

Remember that Layout Tabs are collections of windows that can be arranged any way you want as well as the 
interaction those windows have with each other.   

The TC2000 Default Layout Group includes two Layout Tabs: TC Classic and TC Classic+ (see section 1 of 
these notes).  An easy way to customize your trading environment is to tweak these Layouts so they meet your 
needs in a more personalized way.   

Here's how to modify and save Layout Tabs and Layout Groups. The Move button (and its 

accompanying drop down menu) at the top right of any window is key to quickly 

rearranging your Layout windows. 

Add/Move/Tab Windows 

When you want to add something to an existing Layout Tab, visit the Main Toolbar.  You can generate Charts, 
WatchLists, Notes, Drawing Tools, etc. using corresponding buttons you'll find there. Charts, WatchLists, Notes, 
Drawing tools, etc. are contained within windows.  Three things can happen to a window with regard to 
placement:  

1. UNDOCK: Content generated from the Main Toolbar is often generated in an
undocked window.  Undocked windows can be resized and moved (while
they remain floating within the layout).  If a window is undocked and you
want it to stay that way, do nothing.  If a window is docked or tabbed and you
want to undock it, choose Move Button Drop-Down > Undock

2. DOCK: When windows are docked, they are assigned a specific
section of screen real estate within a Layout.  Windows can be
docked above, below, or beside another window or group of
windows that are already docked. Windows can also be
“swapped” so as to exchange positions in the Layout.

If a window is floating and you want to dock it, or is docked and 
you want to dock it in a new location, choose Move Button > 
One of the Target Mode Arrows 

3. TAB: Multiple windows can be tabbed so that they share the
same section of screen real estate. When windows are tabbed,
you'll see a row of tabs across the top of the tabbed group.  Click one of the tabs to see its content.
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If a window is floating and you want to tab it with another window, or if a window is already docked/tabbed 
and you want to tab it with another window, choose Move Button > Tab Here 

Note: Once windows are tabbed, individual tabs have Move Buttons and the tabbed group has a Move 
Button which allows you to move entire tab groups just as you would a single window. 

Saving Layout Tabs/Layout Groups 

Remember that a Layout Tab is a collection of windows and their interactions. A Layout Group is a collection of 
Layout Tabs.   

To save a Layout Tab, Right-Click Layout Tab > Save Layout Tab or Save 
Layout Tab as… 

To save a Layout Group, select File > Save Layout Group 

To open saved Layout Groups choose File > Open Layout 
Group, or use the Add Layout Button to open a saved 
Layout Tab 

Remember that you can always re-open the Factory Default 
Layout Group (TC Classic and TC Classic+) via File > Open 
Factory Default Layouts. 

News & Notes 

TC2000 Version 12.4 now contains a fully-integrated notes management system and provides consolidated, 

streaming, market-related news.  There are several types of News and Notes windows; you can access any of 

them via the Notes & News button on the Main Toolbar.   

Write a Note (Shift-N) 

To create a Note, either choose this menu item or press <Shift-N> at any time.  

When writing a note, symbols written in this format: $SYM create symbol links 

within your notes once posted, which can be clicked later to view the symbol's 

chart instantly.  You can also attach Charts, WatchLists, EasyScans, or Layouts 

to notes via the Attach drop-down when writing a note.  Attached items can be 

accessed when reviewing notes later. Choose to Post Myself for private notes or 

Post Shared to post notes to the TC2000 User community. 

My Notes: 

See notes that you wrote or posts that you copied to your Notes from another 

news or notes window.  Notes written in previous versions of TC2000 are 

automatically archived in the My Notes window.   
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To copy a post from another news or notes window into your own My Notes window, find the post you'd like to 

copy, click the name of the poster, and select Copy Post to My Notes.  

To comment on any post, click the Add Comment button. Hover your mouse over a post's time stamp for 

specific date and time information.  

Notes & Feeds I'm Following: 

See posts by everyone you're following in TC2000. Add or delete people to/from 

your following list via Notes & News > My Profile > Following  

Explore Feed Windows 

> Expert Opinion Feed: See posts published by professional third-parties. 

 >All Notes, News & Twitter for Current Symbol: See posts created by 
other TC2000 users, aggregated Internet news, related Twitter posts, 
Corporate Calendar events (Platinum only), and any notes you 
may have written about the symbol.   

Use the Edit button to remove any of the types of content you 
wouldn't like to see displayed. 

By default, you'll see a streaming list of symbols along the left of 
the window, which shows the most recently mentioned symbol at 
the top of the list.  Select a symbol from the list to see related 
posts and stories.  If you want to turn the list off, remove the 
check in the By Symbol box.  

> All TC2000 User Notes:  See notes that any other TC2000 user 
posted publically. 

>All News: See only News stories. 

>All Twitter: See only Twitter posts. 

>Full Stream of Notes, News & Twitter: See posts created by 
other users, aggregated Internet news, related Twitter posts, 
Corporate Calendar events, and any notes you may have written.  
The items you see are not limited to a specific symbol.  You will 
see posts for all symbols, system-wide. 

>Corporate Calendar of Upcoming Earnings & Events: See 
announcements for upcoming corporate conference calls, 
Earnings announcements, etc. 

You'll see some basic controls on many Notes & News windows.  If you want the content of a window to 

be dictated by the current chart symbol, place a check mark in the By Symbol box.  If you want to 

manage the types of content that are displayed within a window or would like to adjust font size, use the 

Edit button.  For windows that have a Streaming button, click it to pause or restart content updating for 

the window. 
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The TC Classic and Classic+ Layout Tabs display three Notes & News windows by default.  The three 

windows are tabbed in the bottom-left corner of the Layout Tabs and include News & Notes for Current 

Symbol, My Notes, and Following.  Choose one of the tabs to see its contents.   

Window Properties 

Charts 

Chart properties control the way your charts look.  They can be accessed and 
modified via Right-Click Chart Background > Chart Properties. 

You may want to pay special attention to the Colors and Grid option.  Many people 
want to see charts with a specific background color and either do or do not like grids 
on their charts.  Use Colors and Grid settings to customize your charts.  When 
finished, use the Apply To button to set new defaults.   

Also note the Edit Toolbar option.  If there are certain things you like displayed at 
the top of your charts, Edit Toolbar allows you to make changes to the existing chart 
toolbar.   

WatchLists 

WatchList properties control the way WatchLists 
look.  They can be accessed and modified via 
Right-Click WatchList Background > 
Properties. 

Background color, grid settings, and font sizes 
can all be assigned.  Use the Apply To button 
to set new defaults. 

Maximize window 

Sometimes it's nice to maximize a window so its content is the only thing you see on your screen.  To 
maximize a window, use shortcut <Shift-L> or choose Move Button Drop-Down > Maximize.   

Once maximized, hit <Shift-L>, <Esc>, or the Restore button to return the window to its original 
position. 

Creating Layouts from Starter Layouts 

Starter Layouts 

There's a New Layout Tab button to the right of the Layout Tabs that can 

be used to create a new Layout Tab or to open a recent or previously 

saved Layout Tab.  

When creating a new Layout in TC2000 12.4, you can use what is called 

a Starter Template to make designing the Layout easy.  Click the New 
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Layout Tab button to choose a Starter Layout.  Choose the window design that's closest to what you 

want; then fill the template's windows with the types of content that suit your needs.  

Starter Menu 

You'll choose blank window content from this Starter 
Menu.  Each button corresponds with a type of content 
you might like to see in a window. 

Note the vertical and horizontal splitters.  If/when you 
want to turn one window into two, use these splitters.  
The horizontal splitter turns one window into two 
windows sitting side-by-side.  The vertical splitter turns 
one window into two windows, above and below one 
another. 

Platinum Features 

User Groups 

TC2000 12.4 provides the ability to chat with other users - either individually 

through Private Messaging, or as a group through User Groups. (Platinum only)    

All User Group options can be accessed via the User Groups button located 

in the upper-right corner of the application.There are two default User Groups you 

can join: All-TCNet and Help Forum.  Both are included in tabbed windows within 

the TC Classic+ Layout by default.   

Click to type where prompted within a group.  Charts, WatchLists, EasyScans, and 

Layouts can be attached for others to view via the Attach button within the User 

Group editor.   

Within the User Groups tab of the User Groups dialog, you can search for the 

name of any of the groups you may have been a member of in a previous version 

of TC2000.   

Within a User Group, click a poster's name to access a menu of options, including 

Send Private Message, View Notes, View Profile, Ignore, Send Friend Request, 

Report as Inappropriate, or Copy Post to My Notes.  To manage your Ignored list, 

visit Notes & News > My Profile > Ignored Users.  

You can also initiate your own group via the Create User Group button.  Provide a 

name, and use the Edit button to add invite friends to join.  

Use the Private Messages tab within the Chat dialog to send a 

one-on-one message to another user.  People you're following 

are listed for easy access.  Click a name to begin a private 

message.  Click where prompted to type your message; Charts, 

WatchLists, EasyScans, and Layouts can be attached to private 

messages.   
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Corporate Calendar 

As a Platinum customer, you enjoy access to the Corporate Calendar feature of TC2000.  The Corporate 
Calendar lists upcoming managerial and financial events for publicly traded companies, including: 

 General Meetings

 Conference Calls

 Earnings Announcements

Corporate Calendar events are a part of the basic All Notes, News & Twitter windows that are a part of 
both the TC Classic and TC Classic+ Layouts by default.   

To view the Corporate Calendar independently, choose Main 
Toolbar > Notes & News > Explore Feed Windows > 
Corporate Calendar 

Within the Corporate Calendar, click the Calendar button to copy 
a post to your personal Notes.  Click a symbol to view its chart. 

Full Market Real-Time 

As a Platinum customer, every action you perform in the software and every piece of information you 
study is "instant" as in "right now." Whether you are looking at a sort, chart, social feed, trading room or 
scan result - you should have confidence that it's happening at this precise moment - not a few hours 
ago, not even a few minutes ago.  Your Real-Time market data covers Price and Volume for all stocks 
and ETFs listed on one of the three major American exchanges. 

Any scanning or sorting performed using a Platinum TC2000 account returns results that are instant and 
up to date down to the tick.     

Real-Time Sorting/Scanning 

Remember that when scanning as a Platinum user, you can use the Streaming 
tab, located within every EasyScan.  When you choose the Streaming tab, 
displayed stocks/items that pass specified scan criteria are constantly updated.  
Items that pass the scan are instantly added to the results when they begin to 
pass scan conditions; they are instantly removed from the list when they no longer 
meet the requirements of the scan.  

You can also apply your Personal Criteria Formula (PCFs) to intraday time frames 
with TC2000 Platinum. Simply create your formula and in the Edit window choose 
the time frame upon which you want your condition or indicator PCF based. 
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Checking the Pulse of the Market 

Broad Market Analysis – What is the Market Doing Now? 

Understand Broad Market Conditions 

First, check out what’s going on with the Stock Market.  Take a look at charts for the following symbols: 
SPX, DJ-30, COMPQX.  These should give you a good feel for what the broad Market looks like on 
average.  Take note of how current price levels look in relationship to any significant support and/or 
resistance in the area.   

Next, take note of any significant price formations that are already in place or are in the process of 
development.  Is the Market trending, transitioning, or ambiguous? 

Examine Market Segments 

Next, check out charts for Mid Cap (IWR), and Small Cap Indexes (IWC).  Are large, mid, and small cap 
stocks moving in alignment with one another?  Is one group notably out- or under-performing the others? 
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To add Price plots to the chart for each Index listed above, choose 
the ‘Add Plot to Chart’ button, select the ‘Stocks’ tab, then enter the 
symbol for the Index whose Price plot you would like to see on the 
chart.   

Feel free to leave Price plots separate, or place them within the 
same pane for direct comparison.  If needed, use the Move button for any of the Price plots to relocate 
the original indicator pane or to overlay within another Price pane. 

Remember that if you want to see the list of stocks that make up 
any of the Indexes, select the ‘Components’ WatchList from the 
‘WatchList’ button on the Main Toolbar.   

Look for Market Turning Points 

Be on the lookout for significant turning points for the Market – meaning markers or indicators consistent 
with direction change.  Common markers for intra-trend bounces and pullbacks are the four core Bullish 
Japanese Candlestick Patterns and their Bearish counterparts:  

1. Bullish Engulfing
2. Bullish Piercing
3. Bullish Morning Star
4. Bullish Hammer

1. Bearish Engulfing
2. Bearish Dark Cloud Cover
3. Bearish Evening Star
4. Bearish Shooting Star

Common markers for longer-term directional changes are Western Pattern topping and bottoming formations 
like the Head and Shoulders, Reverse Head and Shoulders, Double Top, Double Bottom, etc. 

Check Out the Breadth of Trend Participation 

To get a feel for the health of a current trend, checking some Breadth Indicators might be useful.  Breadth 
indicators take a plot value or behavior and describe how an entire basket of stocks is behaving with regard 
to that value or behavior.   

One Breadth indicator you might check is called ‘The 
Percentage of Stocks Above the 200 Period Moving Average.’  
This indicator is labeled with the symbol T2107 in TC2000.  Use 
the ‘Add Plot to Chart’ button, and select the ‘Stocks’ tab.  Enter 
symbol T2107, and choose ‘Plot’.   

Now change the symbol of a separate Price plot to SPX, and 
compare the movement of the SPX to that of the T2107.  You’ll 
note that T2107 does a great job of exhibiting leading negative 
divergences when the Stock Market is getting ‘toppy’.   
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If the Market is in a pullback phase, you might try applying a Fibonacci Retracement to see if any of the 
support and resistance level created by the Retracement are close to the 
current Price action.   

To draw a Fibonacci Retracement, you’ll need to open the Drawing Tools 
panel.  From the ‘More’ button on the Main Toolbar, select Drawing Tools.  

Within the panel, select ‘Fib Ret’ then click 
and drag across an appropriate period on a 
chart of SPX.   

Always draw a Fib Retracement across the period defined by the 
‘last, most obvious, complete trend’ on the chart.  This is more of 
an art than a science, but the result will be automatically 
generated horizontal lines that break up the trend you marked 
into Fibonacci percentages – each of which should be treated as 
a possible support / resistance zone going forward. 

Standout Sectors. Standout Stocks. 

What about Sector performance?   

How are the major Market categories performing relative to one another?  There are a couple of different 
ways you could approach this question.   

1. You might take a look at the SPDR Select Sector Exchange Traded Funds, which are designed to track
ten major Market segments.

2. You could look through the Morningstar® Sector and Industry Indexes.  Both of these approaches will
give you an idea of how the Sectors are performing relative to one another.

Since the first method is based on a list of ETFs, the charts you study will be of tradable assets.  The second 
method provides average Price behavior for the group of stocks that 
compose each of the Sectors or Industries studied.   

Should you choose the ETF comparison method, first make a 
WatchList of the SPDR Select Sector ETFs.  To do so, click the 
‘WatchList’ button on the Main Toolbar, and select ‘Create New 
Personal WatchList’.   

Name the WatchList. 
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Within the ‘Symbol’ field for the new WatchList, enter the following 
tickers: XLU, XLB, XLP, XLV, XLY, XLE, XLF, XLI, XLK.  These 
symbols represent Utilities, Materials, Consumer Staples, Health Care, 
Discretionary, Energy, Financials, Industrials, and Technology, 
respectively.   

Once the list is created, Spacebar through the WatchList to view charts 
for each Sector ETF individually.   

As an alternative, add separate Price plots for each ETF by selecting 
the ‘Add Plot to Chart’ button; then select the ‘Stocks’ tab and enter 
one of the ETF symbols.  You’ll need to repeat that process 9 times to 
add plots for each of the ETFs.  Use this method if it’s important to you 
that you be able to see a Price plot style other than ‘Line’ for the ETFs.  
If line graph comparisons are good enough, try the method described 
below. 

Start with a basic chart with one Price History plot on it.  Assign the chart’s symbol to SPX, which displays 
the S&P500 Index on the chart.  Click the name of the Price symbol, and choose ‘Comparison Overlays’.  
Within the blank ‘Symbol’ field, add each of the 9 Select Sectors.  Choose colors for each plot.   

If you want to view relative price performance over the period of history displayed on the chart, place a check 
mark in the box labeled ‘Start all plots at same points’, located near the bottom of the ‘Comparison Overlays’ 
dialog.  In this mode, by changing the zoom level of your chart, you can immediately discern which of the ETFs 
(if any) outperformed or underperformed the others across the period displayed on the chart.   
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If you want to plot each of the ETF’s Prices with independent scales, remove the check in the ‘Start all plots 
at same points’ box.    In this mode, major behavioral characteristics of individual sector ETFs become 
apparent at inflection (turning) points for the Market. 

Remember that for any of the ETFs, if you’d like to view a 
list of the stocks that are represented by the ETF, open a 
‘Components’ WatchList via the ‘WatchList’ button on the 
Main Toolbar. 

If you’d prefer to work with the Morningstar
®

 Sector and Industry Indexes (described in the “What’s New”

section of this workbook), here are some ideas to try.  Please note that the Morningstar
®

 categorizations
used now were recently adopted by TC2000 and are different than the old Industry classification scheme. 

For complete information about the classification system: 

http://corporate.Morningstar.com/us/documents/methodologydocuments/methodologypapers/equityclassmethodology.pdf 

http://corporate.morningstar.com/us/documents/methodologydocuments/methodologypapers/equityclassmethodology.pdf
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Resources for Further Study 

CONTACT 

We're here if you need us! 

Please feel free to send comments to Feedback@TC2000.com.  You can also email either of us: 
Julia.Ormond@Worden.com or Michaelt@Worden.com.  

TUTORIAL VIDEOS 

A library of "how-to" videos is available and constantly being updated. Click the Help menu in your TC2000, 
select Tutorial Videos and then click on desired tutorial link on the opened web page. 

WEBINARS 

Join our frequent Webinars to further your education on TC2000. Webinars are held many Tuesday evenings, 8 
p.m. EST. You can learn about and register for the next webinar at the home page of Worden.com. 

WEBSITES 

Get more information about TC2000 as well as access to lots of training materials and program download links 
at www.Worden.com. (NOTE: sign into all websites with your Worden TC2000 sign-in credentials.) 

FORUMS 

To access the Discussion Forums, click on the Discussion tab at Worden.com if you have general questions 
about TC2000 going forward and need help setting something up. 

-Search 
To Search the Forums click on Search (top right of Forum page). Fill in each field. Be as specific as possible for 
narrower results. You can choose which Forum you wish to search from the drop-down menu. Results will be 
returned as a list of related discussion threads. 

-Ask a Trainer 
The Ask a Trainer forum (for TC2000) is available for you to ask any specific questions related to "how to" do 
anything in the software (e.g. How to write a specific PCF, build a scan, perform a sort, etc.). To ask a question, 
simply click on New Topic, enter your question and post. (You can choose to follow the discussion to receive an 
email when responses are posted.) 

TECHNICAL SUPPORT 

If you have any technical issues with TC2000, please contact Technical Support.  Hours of operation: 
Mon - Fri: 9:00 am - 9:00 pm ET 
Sat: 9:00 am - 3:00 pm ET 
Phone: 919-408-0542 
Fax: 919-408-0545 

For email support: Support@Worden.com  Platinum users have live Support Chat access as well. 

The following are registered trademarks or trademarks of Worden Brothers, Inc.: 
TC2000, TeleChart, TeleChart 2000, EasyScan, MoneyStream, Time Segmented Volume®, TSV, Balance of Power, BOP 

mailto:Feedback@TC2000.com
mailto:Julia.Ormond@Worden.com
mailto:Michaelt@Worden.com
http://www.worden.com/
mailto:Support@Worden.com
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TC2000 Hot Keys (Keyboard Shorcuts) 

To pull up a particular stock, just start typing the symbol or the company name and the list will filter 
automatically. 

To add an indicator or other plot to the chart, press / then start typing the name of the indicator or plot. 

Chart time frame - you can scroll through time frame settings by holding down Ctrl and using the mouse scroll 
wheel. You can go directly to a time frame using the hot key list below. 

Time Frame Key 

Daily 1 

2 days per bar 2 

3 days 3 

4 days 4 

Weekly 5 

6 days 6 

7 days 7 

8 days 8 

Monthly 9 (toggle) 

Quarterly 9 (toggle) 

Yearly 9 (toggle) 

1-minute Ctrl-1 

2-minute Ctrl-2 

5-minute Ctrl-3 

15-minute Ctrl-4 

30-minute Ctrl-5 

Hourly Ctrl-6 

FUNCTION HOT KEY(s) 
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Next symbol in list  Spacebar 

Previous symbol in list  Ctrl-Spacebar 

Backspace through history of viewed symbols Backspace 

Backspace through history of viewed symbols Backspace 

Go to top of watchlist  Home 

Go to bottom of watchlist  End 

Flag/Unflag selected symbol(s)  Shift-F 

Toggle plot style  Ctrl-B (toggles between HLC Bar, OHLC Bar, 
Candlestick and Line plots) 

Move chart backward/forward 1 bar  [ and ] 

Move chart backward/forward 5 bars Shift -[ and Shift-] 

Toggle date pointer Period  ( . ) key. Toggles between Off, on and on with data 
values box 

Custom Date Sort Shift-T 

Write a Note  Shift-N 

Draw Trendline Shift-D 

Zoom in/out on the chart  Mouse scroll wheel 

Pan chart backward/forward Shift + mouse scroll wheel 

Scroll through time frames on the chart Ctrl + mouse scroll wheel 

Maximize window in layout (chart, watchlist, 
etc.)  

Shift-L 

Add selected symbol(s) to My Favorites Shift-V 

Copy selected symbol(s) to one of your personal 
watchlists  

Ctrl-C 

Load chart template 

F1 - F9, F11 and F12 (F10 is reserved in Microsoft Silverlight and cannot be used).  You can edit the templates 
that the F keys are assigned to by clicking the New Chart tab and setting the F keys on individual templates. (If 
you're on a Mac, you have to hold down the 'fn' key while press the F key.) 

Notes: 

The Control key on the Mac is reserved for operations in the Mac OS and is not available to Silverlight 
applications. 

To use hot keys from TeleChart 2007, you need to have this option selected. Click on Tools, System Defaults 
and select the option to "Use TeleChart 2007 Hot Keys". 
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